Investment Account Manager 60 Day Free Demo

Thank you for your interest in Investment Account Manager (IAM) 3 Individual.
WWWw.investmentaccountmanager.com

Designed by professional money managers, and used by investors worldwide since 1985, IAM3
Individual provides extensive investment tracking and portfolio management tools.

The demonstration version of Investment Account Manager is a fully operational version, only
limited by number of days of allowed usage. If you decide not to activate IAM, you will not be
charged anything. If you do decide to purchase IAM, all of the data you have entered into the
trial version will be saved — we simply issue an activation key to convert the demo to fully
operational version.

IMPORTANT NOTE: IAM is a desktop application — it not cloud based. This means that your
personal information stays under your control only, and your data remains totally private.

o Complete the Welcome Screen by entering your name. Note that the software demo has
a 60 day free trial period.
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Welcome to Investment Account Manager 3 Individual

Used by investors worldwide since 1985, Investment Account
Manager (1AM) 3 Individual provides the important portfolio
management tools for:

¢ detaled record keeping,

* comprehensive reporting,

* accurate tax planning,

» performance monitonng,

¢ and asset allocation/rebalancing analysis.

Durning the 60 day trial penod we offer unlimited free support to

answer any questions you may have. Please contact technical
support by calling 262-241-3990, or by using the menu bar choice
to 'Contact Us', Our website also provides many helpful answers,

Also, duning your 60 day free tnal penod, we'll be sending weekly
emails with tips on leaming how to use 1AM3 to help you manage
your investment portfolio(s). Be sure our email address
techsupport@nvestmentaccountmanager.com is added to your
email 'safe senders’ ist so you can receive our emails with links to
tutonal videos.

Please Note: Any data entered into this tnal version will be saved
and available should you decide to purchase the software
activation key to convert the demo to a full featured version.

Thank you for your interest in Investment Account Manager 3
Individual,

e Now click on the Start Demo button.

For technical support, please contact:
Phone: 262-241-3990
Email: techsupport@investmentaccountmanager.com

Demo version is limited to 60 days of free activation from
installation date.

Installed on 04/04/2022
* The expiration date for this demo is 06/03/2022

Please enter your name: UseriD#

2230_762_926

Getting Started Guide Start Demo



The IAM3 Home Page

You should now be looking at IAM's Home Page, and a Welcome Screen from the
comprehensive help system:
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offers a streamlined software tool, providing a comprehensive asset management solution.

Investment Account Manager Professional: Features

Contact Us' menu bar choice to contact our award- winning technical support team.
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IAM’s programmed help is available in two forms — from the top menu bar, as well as from each

feature as you use the program, providing context sensitive help.

e For example, in the left-hand help window pane, select the book titled Chapter 1

Introduction. Select the book titled Home Page Introduction. You’ll find plenty of details

on home page features, and how to navigate.

e You can also view a tutorial video of the IAM3 Individual home page on the Investment

Account Manager website: www.investmentaccountmanager.com.

e When you are ready to move on, close the help system by clicking the “X” within the

help window frame.

Reviewing IAM3 Individual Home Page Display

IAM’s home page is the program’s dashboard. Note that the window includes drop-down
menus, a tool bar, and tabs. The home page allows for easy navigation through the various
windows and reports found in IAM3. The home page displays information about the open

(active) portfolio. Other portfolios can be selected and opened in the left pane.
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Please take some time now looking at the drop-down menus, tool bar, and various dashboard
display tabs while reviewing the sample demo portfolio data. You’ll find for each display tab
context sensitive help as well as a print icon in the right hand corner to review the information

provided. These homepage tabs offer summary details for the current active portfolio:

e Portfolio Summary: portfolio summary details, holdings, costs, market values;

e Positions: current holdings by asset type within the portfolio with costs/market values;
e Transactions: recent activity entered or downloaded for the portfolio;
e Income Received: investment income received for the portfolio for defined date ranges;
e Realized GL: investment gains/losses received for the portfolio for defined date ranges;
e Allocations: asset class allocations in comparison to targeted goals for the portfolio;

e Performance: performance comparison for the portfolio for defined date periods;

e Estimated Income: forward looking estimated income totals for the portfolio;

e Fundamentals: snap shot fundamental valuation ratios for the portfolio (preference);
e All Portfolios: summary totals for all portfolios tracked within IAM3 Individual.

A more in depth look at the Home Page features can be found under the IAM3 Help System:

e Select the Help Menu | Contents Choice

¢ In the left-hand help window pane, select the book titled Chapter 1 Introduction

e Select the book titled Home Page Intro.



Reviewing IAM3 Individual Sample Reports

Another great place to start in learning IJAM3 Individual is to review some of the many detailed
reports the software is able to provide.
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We suggest spending time reviewing the various reports provided by Investment Account

Manager 3 Individual. Select the Reports Menu | Portfolio | and then those reports you might
like to review. You’ll also find within the IAM3 help system is help topic reviewing a few of
these comprehensive reports:

e Select the Help Menu | Contents Choice
e In the left-hand help window pane, select the book titled Chapter 1 Introduction
e Select the book titled Reports and Graphs Intro.

e Select the help topic IAM Reports and Graphs.

e We suggest using the Print icon to print this help topic and then to follow this as a guide
to review reports using the IAM Demo Portfolio 2 for tutorial purposes.

Important note: a distinguishing IAM feature is the ability to combine individual portfolios onto
a single report, for cumulative reporting - very important for unified account management

functions.



Easily Updating Current Market Prices

Investment Account Manager 3 Individual provides automatic pricing sources for your
investment holdings, including QuoteMedia and Yahoo! Finance. Included with the 90 day
demo, as well as with all new software activations, is access with the QuoteMedia data feed.
This pricing feature allows users to easily update all portfolios with IAM for 20 minute delayed
market prices.
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e Click on Update Prices button found on the [AM3 Tool Bar.

e Once prices have been updated, use the OK button to return to the Home Page.

e Just that easily, all portfolios have been updated for timely review of current values, and
better portfolio management tracking of your investments.

Switching Between Portfolios

Investment Account Manager 3 Individual allows for the monitoring and managing of an
unlimited number of portfolios. The left panel of the Home Page provides access to the different
sample portfolios provided with the IAMv3 Individual demo version.
e Click on another portfolio to change to that portfolio, i.e., open that portfolio for the
IAMv3 home page display.
¢ Notice that the IJAM home page now summarizes the portfolio selected. Reminder:
portfolios can be selectively combined on IAM’s many reports for collective reporting
(Reports Menu | Portfolio Reports).

Experimenting with Sample Data

Investment Account Manager 3 Individual allows users a number of ways for setting up their
personal investment accounts. These include:

e Using the Tool Bar | Portfolio Setup Wizard methods;

e Using the File Menu | New Portfolio choice;

e or Using the File Menu | Import choice to import data files from third party
applications/file formats.

Provided on our web site are some detailed video tutorials that will help you learn how to easily
setup your portfolio based upon the degree of past historical data you wish to account for in
IAM3. See here: https://www.investmentaccountmanager.com/iam-tutorials.php. Further, the
online help system offers detailed instructions for setting up your investment account(s).




Before looking a bit closer at some of these available methods, you might like to spend some
time working with the demo sample data and the ITAM3 Activity Ledger, trying some manual
data entry examples. Please note: we also have available on our web site a video tutorial on
using the activity ledger for adding/deleting/editing and other details for listing/viewing your

portfolio investments.
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To take a quick review on using the ITAM3 Activity Ledger:

e Select the Transactions Menu | Add, Edit, Delete Transactions choice.
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e The transactions ledger provides users with a method to manually enter their data in
ledger format, left-to-right, using drop downs to select transaction types, etc. Click on the

next empty line in the ledger to try entering the following.

e Verify the radio button above the column labeled Security is selected to show ‘All

Securities’.

¢ On the next empty detail line, click your mouse in the column labeled Security, and use
the drop down to select any security provided (i.e. Fiserve) with the [AMv3 sample demo

data (securities are added as you build your portfolios).

e Use your keyboard Tab key (or mouse to click) to the Activity column and use the drop

down arrow to select Purchase.




e Use your keyboard Tab key (or mouse to click) to the Quantity column and enter a
sample value, i.e, 25 shares.

e Use your keyboard Tab key (or mouse to click) to the column labeled Unit Price, and
enter a value, 1.e., 100.

e Use your keyboard Tab key (or mouse to click) to the column labeled Comm
(commissions and fees), enter 4.95.

e Notice the Dollar Amount is automatically populated for the cost of this purchase
activity.

e Prior to selecting the Save button, notice in the lower left-hand corner a withdrawal is
selected for the money market offset for this purchase transaction. (This is known as
sweeping or cash pooling). In the lower right portion of the activity ledger, users can
define the offset settlement date to use trade date + 2 or settlement date = trade date.

e Select the Save button.

e Select the Exit button to close the activity ledger.

e The other method to enter transactions is by using our "Classic View" (Transactions
Menu | Add Edit Delete | Classic View). This method provides sequential data entry
screens to record your transactions. You can try this entry method as well, referring to the
help topics as you go along.

Don’t forget: we also have available on our web site a video tutorial on using the activity ledger
for adding/deleting/editing and other details for listing/viewing your portfolio investments.

https://www.investmentaccountmanager.com/iam-tutorials.php

Creating Your Portfolio

IAMv3 Individual allows for an unlimited number of portfolios, thereby providing a tool for
multiple portfolio management. As mentioned earlier, [AM3 offers a number of ways to easy
and flexible methods for creating your portfolio(s). You can view several video tutorials on
using the Portfolio Setup a tutorial to create your portfolio(s) on the tutorials page provided on
our website.

https://www.investmentaccountmanager.com/iam-tutorials.php




Once such method is using the Portfolio Setup Wizard found on the toolbar.

e Update Prices a Broker Download e Refresh Home Page go Backup % Portfolio Setup Wizard /“;ﬁ Yahoo® Quotes [ligl Tutorials 0

{ Portfolio Summary l Positions  Transactions | Income Received “ Rulm‘ Allocations | Performance | Est. Income ” All Portfolios

The wizard is designed to quickly help new users set up their personal information.

- 3
Portfolio Name Existing Portfolios:
| IAM Demo Portfolio 1 A
IAM Demo Portfolio 2
IAM Demo Watch List 1

O pownload current holdings from your online brokerage account.

This method of creating your portfolio in Investment Account Manager enables users to
quickly create portfolios for tracking purposes by downloading current holdings from
their online brokerage account. Learn More

O Import current holdings from a Microsoft Excel (xIs) or comma separated file (csv).

This method of creating your portfolio in Investment Account Manager enables users to
quickly create portfolios for tracking purposes by importing a Microsoft Excel (xls) or
comma separated file (csv). Learn More

O Use quick setup form to manually enter positions.

This method of creating your portfolio in Investment Account Manager simply requires
your most recent brokerage statement or other report listing all current holdings.
Learn More

Advanced Learn More

Next | Cancel || Help |

IMPORTANT NOTE: IAM is a desktop application — it not cloud based. This means that your
personal information stays under your control only, and your data remains totally private.



When using the portfolio setup wizard, users need to make a choice while creating portfolios
(although since IAM provides for unlimited portfolios, users can change their method at
anytime).

e Do I want to start tracking my portfolio as of my current holdings?
e Do I want to start tracking my portfolio as of the beginning of this year?
e Do I want to manually enter all my past history?

Each method has its own advantages — please use the Learn More choices provided in the
Portfolio Setup Wizard form for further details.

Other Methods to Setup your Portfolios

Users can select the File Menu | New Portfolio. There are several methods for setting up your
new portfolio. Each choice provides context sensitive help to guide you thru the process.
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Getting Help

e Our Technical Support Team offers free unlimited support while you use the IAM 3
Individual 60 day demo version. If you have a question, please reach out to us at
techsupport@investmentaccountmanager.com or call:262-241-3990

e Visit our website at: www.investmentaccountmanager.com. It provides explanations,
videos, learning resources, forum to find questions and answers, and more.

Thank you for considering Investment Account Manager v3 Individual for your investing
needs!



